# Table of Contents

NAVIGATION TIP: To navigate directly to a specific section listed in the Table of Contents, hold down the CTRL key while clicking on the page number of that specific section.

**INTRODUCTION** ................................. 5

- OASIS ........................................... 5
- HAVEN/jHAVEN .................................. 5

**GENERAL JHAVEN INFORMATION** ..................... 6

- Installation .............................................. 6
  - New jHAVEN Installation Guide ............ 6
  - Initial Setup Login ......................... 6
- Accessibility ........................................... 6
- jHAVEN User Roles ............................... 9
  - User Roles Access Tables(v.10) .......... 10
- Migration Tool ...................................... 19

**OPENING THE JHAVEN APPLICATION** ................. 19

- Access jHAVEN .................................... 19
  - Possible Error Message ..................... 21
- Login Pop-up Window ......................... 21
  - Initial Setup Login (Default User Login Only) .... 23
  - jHAVEN User Roles - First-time Login ...... 23
  - jHAVEN User Roles - Subsequent Logins .... 25
- The Initial jHAVEN Application Screen ..... 25
  - Home Tab on Welcome Screen .......... 26
  - Home Tab Default ......................... 26
  - Available Hyperlinks Per Home Tab by User ID ..... 26
  - Navigating the Initial jHAVEN Screen ... 31

**JHAVEN ASSESSMENT VALIDATION & DATA ENTRY** .... 34

- General Assessment Information ............ 34
  - Data Entry Field Types ...................... 34
  - Data Entry Edits .............................. 38
- Enforcement ........................................ 41
  - Types of Sequencing ......................... 41
  - RFA Record Sequencing Rules .......... 42

**JHAVEN USER TOOL SEARCH** ............................... 44

- Assessment Search .............................. 44
  - Initiate the Search ......................... 44
  - Use No Criteria .............................. 45
  - Use Specific Criteria ...................... 45
  - Search Summary Result .................... 47
- Assessment Search for Only One Specific Patient .... 48
- Branch AND Patient Searches ............... 49

**MASTER DATA (ADMINISTRATION SCREENS)** .......... 50

- Administration Screens – Common Features .... 50
  - Title Bar ........................................ 50
  - Menu Bar ....................................... 50
  - Tool Bar ........................................ 50
  - Administration Screen Tabs .............. 50
IMPORT DATA FROM OUTSIDE SOURCE.................................................................................................................. 112
JHAVEN APPLICATION REPORTS.......................................................................................................................... 117
  Report Viewer.............................................................................................................................................................. 117
  Print Report............................................................................................................................................................... 117
  Save Report............................................................................................................................................................. 117
  Export Report......................................................................................................................................................... 118
  Available jHAVEN Reports...................................................................................................................................... 118
  Event tracking Reports............................................................................................................................................ 118
  Assessment Data Entry – By Status Report.................................................................................................................. 126
  Assessment Data Entry – By Branch Report.............................................................................................................. 128
  Data Comparison Report........................................................................................................................................... 131
CLOSING THE APPLICATION ........................................................................................................................................ 133
  Session Time Out....................................................................................................................................................... 133
  Save Resources Pop-up Window............................................................................................................................... 134
  Logout......................................................................................................................................................................... 135
  Exit.............................................................................................................................................................................. 136
  Data Backup on Close................................................................................................................................................ 136
SECURITY ...................................................................................................................................................................... 139
  Change Security Answers.......................................................................................................................................... 139
  Change Password...................................................................................................................................................... 140
  Logout......................................................................................................................................................................... 142
HELP ......................................................................................................................................................................... 143
  Help Option from Menu Bar...................................................................................................................................... 143
  Help Search.............................................................................................................................................................. 144
  Help Contents......................................................................................................................................................... 147
  About Quality Management System........................................................................................................................ 148
MISCELLANEOUS SYSTEM MAINTENANCE ........................................................................................................ 150
  Passwords............................................................................................................................................................... 150
  Password Rules....................................................................................................................................................... 150
  Forgotten Passwords................................................................................................................................................ 150
  Locked Accounts..................................................................................................................................................... 152
    Data Entry User & View Only User Account Locked............................................................................................. 152
    System Administrator Account Locked.................................................................................................................. 152
  Database Backup and Restore.................................................................................................................................. 153
    Database Backup.................................................................................................................................................... 153
    Changing the Backup File Location....................................................................................................................... 153
    Restore the Database from Backup......................................................................................................................... 155
UNLOCK CLIENT/SERVER RECORDS .......................................................................................................................... 157
  Unlock using Assessment Search Screen.................................................................................................................... 157
  Unlocking Records using the Locked Pop-up Window............................................................................................... 158
Introduction

OASIS

The Outcome Assessment Information Set (OASIS) was developed by the Centers for Medicare & Medicaid Services (CMS) to set a standardized protocol for assessing the clinical characteristics of Home Health Agency (HHA) patients. This information is used to better support the regulatory process and policy-making by providing survey agencies with a mechanism for objectively measuring Agency performance and quality. It also is used to support a prospective payment system for HHAs. In addition, it provides researchers with a rich set of information to support the development of improved standards of care through the study of patient care outcomes.

The purpose of the OASIS National Automation Project is to provide computerized storage, access, and analysis of the OASIS data on HHA patients across the U.S. The OASIS System consists of several interrelated components, including data communications and an OASIS National Data Repository, and is intended to create a standard, nationwide system for connecting HHAs to their respective State agencies for the purpose of electronic interchange of data, reports, and other information.

For more detail, go to the CMS website:

HAVEN/jHAVEN

To achieve their goals, CMS has sponsored the development of a data entry system known as the OASIS Home Assessment Validation and Entry (HAVEN) System. The new version will be jHAVEN, converted to use Java. HHAs can use jHAVEN for collecting OASIS data in a standardized format and electronically creating OASIS data records to be sent directly into the ASAP system.

Two (2) OASIS Data Specifications are used in jHAVEN.

- OASIS-C, version 2.10
- OASIS-C1, version 2.11

jHAVEN is designed to work with external screen reader software (e.g., JAWS) for compliance with Section 508. At the login screen, users have the checkbox option to select “enhanced 508 features”. This option should be checked when an external screen reader will be used.
General jHAVEN Information

Installation

jHAVEN may be used as a standalone application or in a network configuration.
- A standalone installation is used on an independent user workstation.
- A network installation is intended to be used for a group of users with a designated database server in a separate location.

New jHAVEN Installation Guide

Installation instructions, with Hardware/Software Specifications, are located in the “jHAVEN Installation Guide”. A copy of this guide may be found on the following websites:
- The CMS Website: https://www.qtso.com/cmslinks.html
- The QTSO Website: QIES Technical Support Office - jHAVEN Download

Initial Setup Login

For initial login, using the default User ID, please consult the jHAVEN Installation Guide. That is the guide, which details the Initial Setup Login process.

After the initial Login is completed, the default user must add an agency and the first System Administrator. See the TOC to locate the following detail sections.
- Agency Screen – Add & Maintain an Agency
- User Screen – Add & Maintain a User

Accessibility

Selecting the ‘Enable Accessibility Features’ check box at the bottom of the login screen will turn on accessibility features for users requiring assistive technology (e.g. screen readers).

By default, the ‘Enable Accessibility Feature’ check box will be checked the first time the Login pop-up displays. This checkbox being checked indicates Accessibility features are turned on.
The User may determine whether they wish to use the accessibility features by either checking or unchecking the check box. The check box will remain checked, or unchecked, until changed by the user when the user logs into the application again.

The Home pop-up window for Accessibility displays the “Welcome to jHAVEN”.

“This is the Welcome message for jHAVEN. After closing this dialog box, press the ALT key to enable the drop down menu to perform jHAVEN administration activities and assessment entry. User CONTROL + Page Up and CONTROL + Page Down to switch between open screens. Press ALT + J to get additional information about that screen. Currently, the screen that is open is used to detail the various sections of jHAVEN. It consists of multiple sections, each with a button to take the user to the section described.”

If the user chooses to use the accessibility features, the Accessibility icon will display in the tool bar on screens within jHAVEN. The user can either click on the icon or use ALT+J to open the accessibility screens.
These informational pop up screens explain the layout of the open screen and provide shortcut key-board
combinations to move the cursor around the page. For example, ALT+1 on the Agency screen will move
the cursor to the beginning of the agency data entry section. When the cursor is on an arrow beside a
field, the space bar will expand/collapse a section of data.

NOTE: When using key combinations such as ALT+1, the numbers
across the top of the keyboard should be used rather than the numeric
keypad.
jHAVEN User Roles

The User Roles available in jHAVEN include:

- System Administrator
- Data Entry
- View Only

The specific User Role assigned to a user determines what functionality is available to that user.

Sample below illustrates the access available under the “File” menu item with an active Agency screen for the three (3) jHAVEN User Roles and matches up with the table below.

To enhance security of data in the application, each user type has a different level of access.

1. All Users will have the Accessibility option if Accessibility is turned on.
2. The System Administrator user has access to add new, delete existing and modify any agency records.
3. The Data Entry user may view, open, update and close the agency record with which they are associated.
4. The View Only user has no access to the agency records.
5. All Users will be able to Exit the tool.

The following table provides a summary of the valid user roles and their access rights within the jHAVEN tool. Access is listed by Menu Options based on which screen is active.
User Roles Access Tables

Table legend:
- ‘Yes’ indicates that the Menu Item is available AND the Option is in the dropdown, therefore available.
- ‘No’ indicates that the Menu Item is available, BUT the Option is NOT in the dropdown, therefore unavailable.
- Dash (-) indicates that the Menu Item is NOT available to the user and therefore there will be not dropdown with Options.
- ‘*’ Indicates Save will be enabled only when there are any unsaved changes on the active Admin screen.
- ‘***’ Indicates Save All will be enabled only when there are unsaved changes on any of the open Admin screens. Unsaved changes do not necessarily have to be on the active Admin screen.
- ‘****’ Indicates Accessibility will be available only if the Enable Accessibility Features checkbox is checked at login.
- ‘#’ Indicates Menu bar items of Administration, Import/Export, Reports and Assessment will not be available when the Assessment is open.
- ‘##’ Indicates Alt Keys are valid only if that user has access to that function.

Footnotes:
1 Alt Keys are valid only if that user has access to that function.
2 Under the File Menu item, only those menu options available to that user, will have icon(s) in that user's tool bar. If the option is not available to user, then the icon will not appear in the user's tool bar.
Exception: 'Save All' and 'Change Backup File Location' are only available in the File Menu; NOT on the Tool Bar.
3 The Tabs, Panels, and Button are all available on the Assessment Screen. However, the remaining sections will be available dependent upon the type of Assessment. Check the Data Sets to determine which sections should be available for each type of assessment.

The following tables document the jHAVEN access by User Roles and Screen Menu Dropdown and/or Application Screens.

**Menu Bar Dropdown Options**

<table>
<thead>
<tr>
<th>Menu Option – Administration (Alt+A)</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency</td>
<td>Ctrl+F</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Branch</td>
<td>Ctrl+B</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Patient</td>
<td>Ctrl+T</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>Ctrl+R</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Locked Records (only on Network Client/Server installation)</td>
<td>Ctrl+Alt+L</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu Option – Import/Export Menu (Alt+I)</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import</td>
<td>Ctrl+I</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Export</td>
<td>Ctrl+E</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Menu Option – Reports Menu (Alt+R)

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+T</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+D</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+I</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Menu Option – Security Menu (Alt+U)

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+C</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Menu Option – Assessment Menu (ALT+M)

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+N</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Menu Option – Help Menu (Alt+H)

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+Alt+R</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+H</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+A</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Ctrl+Alt+W</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### Menu Bar Dropdown Options Available based on Active Screen

#### File Menu – No Active Screens

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+S</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

#### File Menu – Home Screen Active

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+S</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Shift+S</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+O</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Alt+F4</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Home Page HOT Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go To Agency</td>
<td>Alt+G</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Branch</td>
<td>Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To User</td>
<td>Alt+S</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Patient</td>
<td>Alt+P</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Assessment Search</td>
<td>Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Import</td>
<td>Alt+O</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Export</td>
<td>Alt+X</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Event Tracking</td>
<td>Alt+K</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Assessment By Status</td>
<td>Alt+T</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Data Comparison</td>
<td>Alt+Y</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To Enforcement</td>
<td>Alt+N</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Go To User Guide</td>
<td>Alt+D</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Do not display this home screen after logging into the application</td>
<td>Alt+L</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### File Menu – Agency Screen Active HOT Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+G</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Close Agency</td>
<td>Ctrl+O</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>New Agency</td>
<td>Ctrl+N</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Delete Agency</td>
<td>Ctrl+D</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Agency Screen - Page Active HOT Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency Summary</td>
<td>Alt+L</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Agency Detail</td>
<td>Alt+1</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Agent Information</td>
<td>Alt+2</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>
## File Menu – Branch Screen Active

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Close Branch</td>
<td>Ctrl+O</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>New Branch</td>
<td>Ctrl+N</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Delete Branch</td>
<td>Ctrl+D</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

## Branch Screen – Page Active

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch Summary</td>
<td>Alt+L</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Branch Detail</td>
<td>Alt+1</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Branch Contact Person</td>
<td>Alt+2</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Actions</td>
<td>Alt+3</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Search Criteria</td>
<td>Alt+T</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Search</td>
<td>Alt+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Clear</td>
<td>Alt+C</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>First Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Previous Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Next Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Last Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Return all rows</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Add Branch</td>
<td>Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Delete Branch</td>
<td>Alt+D</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
</tbody>
</table>

## File Menu – Patient Screen Active

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Close Patient</td>
<td>Ctrl+O</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>New Patient</td>
<td>Ctrl+N</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
</tr>
<tr>
<td>Delete Patient</td>
<td>Ctrl+D</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

...continued to Patient Page
### Patient Screen – Page Active

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Summary</td>
<td>Alt+L</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Patient Detail</td>
<td>Alt+1</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Actions</td>
<td>Alt+2</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Search Criteria</td>
<td>Alt+T</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Search</td>
<td>Alt+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Clear</td>
<td>Alt+C</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Show Hidden</td>
<td>Alt+W</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>First Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Previous Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Next Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Last Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Return all rows</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Add Assessment</td>
<td>Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Add Patient</td>
<td>Alt+P</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Delete Patient</td>
<td>Alt+D</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>View Assessment</td>
<td>Alt+V</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### File Menu – User Screen Active

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Close User</td>
<td>Ctrl+O</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>New User</td>
<td>Ctrl+N</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Delete User</td>
<td>Ctrl+D</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### User Screen – Page Sections

<table>
<thead>
<tr>
<th>HOT Keys</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Summary</td>
<td>Alt+L</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>User Detail</td>
<td>Alt+1</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Activation Detail</td>
<td>Alt+2</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Agency Detail</td>
<td>Alt+3</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

...continued to File Menu - Import Screen Active
### Menu Bar & File Menu – Import Active

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Close Import</td>
<td>Ctrl+O</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

### Import Screen – Page Sections

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Do not give warning when new patient is added during import</td>
<td>Alt+P</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Do not display warnings in error check results.</td>
<td>Alt+W</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Assign Exported status to assessments without errors (instead of Export Ready)</td>
<td>Alt+X</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Associate Assessments with a blank Agency ID field to the selected Agency below</td>
<td>Alt+T</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Select All Options / Deselect Options</td>
<td>Alt+S</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Error Check File</td>
<td>Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Import</td>
<td>Alt+O</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Menu Bar & File Menu – Export Screen Active

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Close Export</td>
<td>Ctrl+O</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

### Export Screen – Page Sections

<table>
<thead>
<tr>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse</td>
<td>Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Select All</td>
<td>Alt+L</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Clear Selection</td>
<td>Alt+C</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Print Assessment List</td>
<td>Alt+P</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Error Check</td>
<td>Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Export</td>
<td>Alt+X</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Menu Bar Dropdown Options Available based on Active Assessment Screens

<table>
<thead>
<tr>
<th>Menu Bar &amp; File Menu – Assessment Search Screen Active</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Print Assessment Report</td>
<td>Ctrl+A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Close Assessment Search</td>
<td>Ctrl+O</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Change Backup File Location</td>
<td>Ctrl+Alt+B</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Assessment Search – Page Sections

<table>
<thead>
<tr>
<th>Assessment Search – Page Sections</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Criteria</td>
<td>Alt+T</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Search</td>
<td>Alt+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Clear</td>
<td>Alt+C</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Show Hidden</td>
<td>Alt+W</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Show Only Locked Assessments (only on Network Client/Server installation)</td>
<td>Alt+K</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>First Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Previous Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Next Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Last Page</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Return all rows</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Edit Assessment / View Assessment</td>
<td>Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>View Only</td>
<td>Alt+V</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Delete Assessment</td>
<td>Alt+D</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
<tr>
<td>Unlock Assessment (only on Network Client/Server installation)</td>
<td>Alt+L</td>
<td>-</td>
<td>Yes</td>
<td>-</td>
<td>-</td>
<td>N/A</td>
</tr>
</tbody>
</table>

Menu Bar & File Menu – Assessment Screen Active

<table>
<thead>
<tr>
<th>Menu Bar &amp; File Menu – Assessment Screen Active</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Save</td>
<td>Ctrl+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>**Save All</td>
<td>Ctrl+Shift+S</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Save and Validate</td>
<td>Ctrl+U</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>-</td>
<td>Yes</td>
</tr>
<tr>
<td>***Accessibility</td>
<td>Alt+J</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Print Assessment Report</td>
<td>Ctrl+A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Print Assessment Error Report</td>
<td>Ctrl+P</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Close Assessment</td>
<td>Ctrl+O</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Exit</td>
<td>Alt+F4</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

...continued to Assessment – Page Section
## Assessment - Page 4 Sections

<table>
<thead>
<tr>
<th>Section</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigator Panel</td>
<td>Alt+N</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Assessment Tab</td>
<td>Alt+A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Patient Details Tab</td>
<td>Alt+P</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Agency Details Tab</td>
<td>Alt+G</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Assessment Determination Tab</td>
<td>Alt+D</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Patient Tracking Sheet</td>
<td>Alt+1</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Clinical Record Items</td>
<td>Alt+2</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Patient History and Diagnoses</td>
<td>Alt+3</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Living Arrangements</td>
<td>Alt+4</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Sensory Status</td>
<td>Alt+5</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Integumentary Status</td>
<td>Alt+6</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Respiratory Status</td>
<td>Alt+7</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Elimination Status</td>
<td>Alt+8</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Neuro/Emotional/Behavioral Status</td>
<td>Alt+9</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>ADL/IADLs</td>
<td>Alt+0</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Medications</td>
<td>Alt+!</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Care Management</td>
<td>Alt+@</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Therapy Need and Plan of Care</td>
<td>Alt+#</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>HIPPS</td>
<td>Alt+$</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Print Error Report Button</td>
<td>Alt+R</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
<tr>
<td>Edits Panel</td>
<td>Alt+E</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
</tr>
</tbody>
</table>

## Additional Assessment Screen Icons

<table>
<thead>
<tr>
<th>Icon 2</th>
<th>HOT Keys ¹</th>
<th>Default User</th>
<th>System Admin</th>
<th>Data Entry</th>
<th>View Only</th>
<th>Icon ²</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Answered Questions Icon</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Pause Timer Icon</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigator Panel - Assessment Icon</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigator Panel - Section Icon</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Navigator Panel - Field Icon</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Grid Icon</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Move Up (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Move Down (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>New (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Insert (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delete (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Verify (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Close (within Grid pop-up)</td>
<td>N/A</td>
<td>-</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

...Continued to Additional Icons
Migration Tool

The process steps for utilizing the Migration Tool are covered in the “jHAVEN Migration Guide”.

Opening the jHAVEN Application

Access jHAVEN

Once jHAVEN has been installed and the ‘initial setup’ has been successfully completed, access the program using one of the following methods.

Start menu All Programs – click the jHAVEN folder in the start menu to list the available links:
- jHAVEN User Guide
- jHAVEN
- Uninstall
- www.cms.gov
- www.qtso.com

Desktop ICONs – double click the icon found on the desktop.
NOTE: Only one of these ICONs will be on the desktop.

From the Installation Folder – navigate to the folder where jHAVEN was installed, double click the jHAVEN.exe file.

The jHAVEN splash screen displays momentarily.

The Welcome to jHAVEN screen displays while the program is loading. This may take a few minutes and requires no response from the user.
The welcome tab on the Welcome screen can be closed by clicking the white ‘X’ that appears after the tab title “Welcome”. This may only be done if the Login pop-up window has not yet been displayed.

**Possible Error Message**

Only one copy of installation of jHAVEN may be running at one time.

**Login Pop-up Window**

The title bar of the login screen will include the User Tool acronym (jHAVEN) and software version number (1.x or 1.x.x). Accessibility can be turned off on this pop-up window by removing the check in the checkbox. If the check is left, then Accessibility will be turned on. For more details see [Accessibility](#).
Initial Setup Login (Default User Login Only)
For the initial login as a ‘default user’, please consult the jHAVEN Installation Guide for details on how to complete the Initial Setup Login process.

jHAVEN User Roles - First-time Login
Complete the following steps to login to jHAVEN for the first time.

1. In the User ID field, enter the User ID, which was assigned by the System Administrator.
2. Enter this same User ID into the Password field.

   NOTE: The User ID and Password are case sensitive.

3. Click Login.
   a. The ‘Change Password’ screen displays. Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:
      i. “The new password and the confirm new password must match.”
      ii. “The new password must be at least 8 characters long.”
      iii. “The new password must be no more than 20 characters long.”
      iv. “The new password must not contain any space.”
      v. “The new password must not contain the User ID, First Name, Last Name, or Email.”
      vi. “The new password must not begin with a number.”
      vii. “The new password can only contain a maximum of 3 repetitive characters.”
      viii. “The new password must contain at least one for each of the following type of characters.”
         ix. “Upper-case Character: A-Z”
         x. “Lower-case Character: a-z”
         xi. “Number: 0-9”
         xii. “Special Character: - &~!@#$%^*()_+={}\|;:'",<>.?/”
         xiii. “The new password must not match any of the user’s most recent 6 passwords.”
         xiv. “The new password will be set to expire in 60 days.”
4. Enter a new password in the New Password and Confirm New Password fields. These must be identical.
5. Click the ‘Continue’ button to complete the login process.

NOTE: When Cancel is clicked, then another Change Password pop-up comes up with the following message: “You must change your password before accessing the system. If you do not change the password, you will be logged off the system”. Clicking the ‘Cancel’ button on this pop-up takes the user back to the previous Change Password pop-up. Clicking OK takes the user to the login screen.

6. The Security Questions screen displays. It is required that the user respond to at least six (6) of the ten security questions listed.
   a. “What city were you born in?”
   b. “What year did you graduate from high school?”
   c. “What is your favorite sport?”
   d. “What was the make of your first car?”
   e. “What was the color of your first car?”
   f. “What is your mother’s maiden name?”
   g. “What was the name of your first pet?”
   h. “What size shoe do you wear?”
   i. “What is your favorite season of the year?”
   j. “What is your favorite movie?”
Note: The user must tab forward after entering their last answer, in order to enable the “OK” button.

7. Click OK.
   The jHAVEN screen displays.
8. Continue on with The Initial jHAVEN Application Screen

**jHAVEN User Roles - Subsequent Logins**
Complete the following steps to login to jHAVEN if this is NOT the first time doing so AND you have set up your password successfully.

1. Enter the User ID assigned by the System Administrator user, in the User ID field.
2. Enter the Password you have created into the Password field.

NOTE: The User ID and Password are case sensitive.

3. Click Login.
4. The jHAVEN application screen displays.
5. Continue on with The Initial jHAVEN Application Screen

**The Initial jHAVEN Application Screen**

When the user has successfully logged in, the application screen displays will become available based on User Role using the Menu items.

1. The Default User will have access to the Menu Bar items: File, Administration, Security, and Help.

   NOTE: See the Installation Guide for the default users access and initial setup.
2. The System Administrator will have access to the Menu Bar items: File, Administration, Import/Export, Reports, Security, Assessment, and Help.

3. Data Entry User will have access to the Menu Bar items: File, Administration, Reports, Security, Assessment, and Help.

4. View Only User will have access to the Menu Bar items: File, Reports, Security, Assessment, and Help.

NOTE: The specific User Role assigned determines what functionality is available to that user. See User Roles Access Table above for details of this access.

6. Continue on to the next section.

**Home Tab on Welcome Screen**

The first screen to be displayed is the jHAVEN Application Welcome screen. This screen will contain the Home Tab by default, which is dynamic based on the User’s assigned User ID.

**Home Tab Default**

At the bottom of the Home tab, there is one “Do not display this home screen after logging into the application.” check box. The default is the check box will be initially unchecked; indicating to display the Home tab each time the user successfully logs into the application.

The User may check the check box. When this is done, this screen will not continue to display.

NOTE: The Home tab setting is unique to each user, and remains unchanged until the user changes it using the check box. This is true even when the software is upgraded; the settings will remain the same.

**Available Hyperlinks Per Home Tab by User ID**

**Default User**

See the jHAVEN Installation Guide for the details for the ‘default users’ Home tab.

**System Administrator**

After the System Administrator is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar.
1. The System Administrator will have access to:
   - The Menu Bar items and their drop down options: File, Administration, Reports, Security, Assessment, and Help.
2. Each user will initially have the Home tab.
   - The “Go To” action buttons for the System Administrator will be: Agency, Branch, Patient, Import/Export, Assessment, Enforcement, Reports, and jHAVEN User Guide.
## What would you like to do?

### Agency
The Agency screen is used to add, modify, or delete agency records.

- **Go To Agency**

### Branch
The Branch screen is used to add, modify, or delete branch records. Branches associated to exported assessments cannot be modified.

- **Go To Branch**

### User
The User screen is used to maintain user access to jHAVEN and set default Branch association.

- **Go To User**

### Patient
The patient screen is used to add, modify, or delete patient records, as well as add assessments to the system.

- **Go To Patient**

### Assessment
The Assessment search screen is used to find, view, or delete assessments.

- **Go To Assessment Search**

### Import/Export
The Import and Export screens are used to error check and bring assessments in and out of the jHAVEN database.

- **Go To Import**
- **Go To Export**

### Reports
Reports are generated based on data within the jHAVEN database.

- **Go To Event Tracking**
- **Go To Assessments By Status**
- **Go To Assessments By Branch**
- **Go To Data Comparison**

### Enforcement
The Enforcement dialog allows strong or weak sequencing rules to be set by the system administrator.

- **Go To Enforcement**

### User Guide
The User Guide will guide the user through the step by step process of creating Agencies, Users, and Patients, as well as creating and processing Assessments.

- **Go To User Guide**

---

*Do not display this home screen after logging into the application.*
Data Entry User

After the Data Entry User is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar.

1. The Data Entry User will have access to:
   - The Menu Bar items and their drop down options: File, Administration, Reports, Security, Assessment, and Help.

2. Each Data Entry user will initially have the Home tab.
   - The “Go To” action buttons for the Data Entry User will be: Agency, Branch, Patient, Assessment, Reports, and jHAVEN User Guide.
View Only User

After the View Only User is successfully logged in, the application Welcome screen will become available with a Menu Bar and a Tool Bar.

1. The View Only User will have access to:

1. Each View Only user will have the Home tab initially.
   - The “Go To” action buttons for the View Only User will be: Assessment, Reports, and jHAVEN User Guide.
Navigating the Initial jHAVEN Screen
The ‘Go To’ Action buttons are used to navigate directly to an application screen, pop-up window, or the User Guide. Each button has verbiage to indicate how it is to be used. Examples using the Home Tab Buttons for navigating are the following sub-sections.

Navigating to the Agency Screen
The following flow is illustrated using the ‘Go To Agency’ button. This hyperlink takes the user directly to the Agency screen.

Complete the following steps:
1. Log into the application.
2. Click on the ‘Go To Agency’ button.
3. The Agency screen displays.

   a. The Agency screen displays with all of the agency data that is currently available.
   b. The user may view and/or manipulate the data as their access allows.
4. Close the Agency screen, and any other open Administration and/or Assessment screens.
5. The Home tab is displayed.

NOTE: If the ‘do not display’ check box, at the bottom of the Home tab, is checked, then the Home tab will no longer be displayed.
Navigating to a Pop-up Window

The following flow is illustrated using the ‘Go To Assessment by Status’ button. This hyperlink takes the user directly to the Criteria pop-up window required for the Assessment Data Entry – Status report.

Complete the following steps:

1. Log into the application.
2. Click on the ‘Go To Assessment by Status’ button.
3. The Assessment Data Entry – By Status Criteria pop-up window displays.
   a. The Data Fields are all required:
      i. Agency
      ii. Status
      iii. Data Entry Date: From and To
   b. Select the Agency, Status (or Statuses), and the Data Entry From and To Dates.
   c. Click the ‘OK’ button.
4. The Criteria screen closes and the Report Viewer will display the report.

NOTE: If the ‘do not display’ check box, at the bottom of the Home tab, is checked, then the Home tab will no longer be displayed.
Navigating to the User Guide

When the ‘Go To User Guide’ button is used, the .pdf copy of the User Guide for jHAVEN is opened and displayed. If the application cannot find the User Guide where it is expected, the following error message displays.

1. Click the ‘OK’ button.
2. Contact your System Administrator.

NOTE: The User Guide may always be located on the QTSo Website: https://www.qtso.com/havendownload.html
jHAVEN User Guide, v1.0.1

jHAVEN Assessment Validation & Data Entry

General Assessment Information

Data Entry Field Types

Text
Text fields allow data to be entered manually, which adheres to the submission rules (length, alpha, numeric, special characters, etc.) for each specific field. These fields may be required or optional.

If a text field is a required field and nothing is entered into it, and the user tabs past it, a warning message will be displayed.

The following are examples of text fields taken from the patient screen: Patient First Name, Patient Middle Initial, Patient Last Name, Patient Suffix.

Date
Date fields are formatted for the entry of a valid date. The date may be entered manually or, if accessibility is turned OFF, by clicking on the calendar next to the date field and selecting a date.

The valid format of all dates will be MM-DD-YYYY.

Where: MM= Month = 01-12, DD= Day = 01-29, 30, or 31, depending on the month, and YYYY equals the four digit year.

The following is an example of a date field.

Checkbox
Check boxes allow the selection of values associated with each box. If the check box is checked the value will be included. If the check box is not checked, it will not be included.

The following is an example of this type of checkbox.
**Checkbox used with Other Data Fields**

There are data fields of various types that must have required input. However, at the time the assessment is performed all of this information may not be known. Therefore, a checkbox is provided to indicate that the user has not skipped this item, but, in fact, does not have the information. Thus, ‘required’ data has been provided.

Later in the verification process this may result in an error, which the user must correct by actually supplying the requested data.

For Example, they are used here with Text fields.

1. The Medicare Number is not known, the check box is checked.
2. The Social Security Number is also known or available, the check box is checked.
3. The Medicaid Number is known and was entered; therefore the check box below it was disabled.

**Dropdown List**

Dropdown lists contain allowable answers to a specific field. To answer a dropdown question, tab to the field and use the arrow keys on the keyboard to navigate through the answer options. Once the appropriate answer is displayed, use the Tab key to move to the next question. A mouse may also be used to select an answer in a dropdown list. Click the arrow on the right side of the field to expand the list. Click the desired answer. Click the mouse on the next question. The Delete key on the keyboard can be used to clear the field. The following is an example of a dropdown list.
List Box
A List Box is a display-only box that the application populates. The first row will contain the field name, plus the field’s M00#, if it exists. The remaining row(s) will be populated with data selected by the User.

These List Boxes are most often associated with Grid fields.

Grid
Grid buttons are used for selection of one or more values, usually including a large number of selection options.

Click on the grid button and a series of pop-up windows containing a list of items from which to choose. The user may select one or more of these items.

Here are examples of the use of the Grid related to the ICD-9-CM Codes for assessments using OASIS-C.
The Grid opens up to an empty selection list. The ‘New’ icon will display a pop-up list of all the appropriate diagnosis codes, from which the user may select the code, or codes, they require.

The user may then insert their selection. Errors will be provided as found.

Once verified, the pop-up should be closed.

The jHAVEN application will then pull the user’s selection(s) into a List Box, which is a display-only field.
This box will be expanded to accommodate multiple selections.

If the user wishes to modify this selection, they must return to the Grid button and repeat the process.

**Data Entry Edits**

*Edits*

Data edits are applied to the fields during the data entry process into jHAVEN.

NOTE: These edits are unique messages to assist users with the accurate completion of data entry. Some will present a pop up message and must be addressed at the time they are displayed in order to proceed. Some edits may not appear until the entry is saved & validated.

The error messages are assigned numbers to aid in trouble shooting. When there are questions about a message, it is beneficial to record the message before calling the Help Desk. This can facilitate quicker answers and/or resolutions.
Error Messages
This type of edit message lets the user know information entered is incorrect or missing. It must be corrected or entered before the information will be saved. This is referred to as a “fatal” error.

![Error Message Example]

The ‘X” symbol identifies this message as a Fatal Error Message.

Warning Messages
This type of message indicates there is information entered that should be verified as accurate, or serve as a reminder of how some fields should be populated.

![Warning Message Example]

The ‘!” symbol identifies this message as a Warning Message.
**Decision Messages**
This type of message requires a decision on the part of the User. This message may also include additional information to aid the User in their decision. The decision will most often directly affect the process.

The ‘?’ symbol identifies this message as a Decision Message.

**Informational Messages**
This type of message indicates that something may, or has, occurred. These provide additional information about the field or the process.

The ‘I’ symbol identifies this message as an Informational Message.
**Enforcement**

Enforcement of Assessment Sequencing was turned on during installation, as a system default. The System Administrator is the only user who may turn this off and/or on after the installation is completed successfully and application start-up” has occurred.

Assessment Enforcement sequencing rules are used in only in conjunction with adding assessments.

**Types of Sequencing**

There are two (2) types of sequencing: 1) Strong Enforcement and 2) Weak Enforcement.

**Strong Enforcement**

Strong enforcement of assessment sequencing is automatically set when the software is installed. This type of sequencing provides an error whenever a newly added assessment violates the sequencing rules. It prohibits that specific type of assessment from being added.

**Weak Sequencing**

Weak enforcement of the assessment sequencing may be set by the System Administrator after the completion of installation of the software. This type of enforcement provides a warning, which indicates that sequencing is being violated. However, it does NOT prohibit the assessments type from being added.

The following steps should be completed to set the Enforcement switch after installation:

1. Select the Enforcement option from the Assessment drop down on the Menu Bar.

2. The default is ‘Strong Enforcement’.
   a. To switch this over to ‘Weak Enforcement’, uncheck the checkbox in front of “Enable Strong Enforcement”.

![jHAVEN Menu Bar with Enforcement Option](image-url)
1. Click ‘Save’ icon.
2. The Enforcement is reversed.

NOTE: To re-set or reverse Enforcement, re-check the checkbox.

**RFA Record Sequencing Rules**

The sequence of records for a patient must conform to certain requirements. For example, a resumption of care record cannot directly follow a start of care assessment record. The following table indicates allowable sequences of records. In this table, the abbreviation *RFA* is used to represent the “reason for assessment” contained in item M0100_ASSMT_REASON. X’s in the table are used to indicate allowable record sequences.

To understand this table, consider a sequence of records for a particular patient served by a particular home health agency and assume that the records are ordered by effective date as defined above. Let’s suppose a particular record in the sequence is designated *Record A*. If Record A is immediately followed by a second record in the sequence (called *Record B*), the table below can be used to determine what RFAs are allowed for Record B.

For example, suppose Record A has an RFA of 03 (resumption of care after inpatient stay). We can see from the row labeled “03” that there are check marks under RFAs 04 through 09. This means that if a record with an RFA equal to 03 occurs in the record sequence and if it is immediately followed by another record, that record must have an RFA equal to 04, 05, 06, 07, 08, or 09.

<table>
<thead>
<tr>
<th>RFA - Rec A</th>
<th>Rec B - 01</th>
<th>Rec B - 03</th>
<th>Rec B - 04</th>
<th>Rec B - 05</th>
<th>Rec B - 06</th>
<th>Rec B - 07</th>
<th>Rec B - 08</th>
<th>Rec B - 09</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>03</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>04</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>05</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>06</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>07</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Page 42 of 160
In general, the initial record in a sequence of records will have an RFA of 01 (start of care – further visits planned). However, there can be exceptions to this general rule. One example involves patients who turn 18 while under care. For these patients, the HHA is not required to do a start of care assessment, but must instead submit data for the next required comprehensive assessment. Another example occurred when the OASIS electronic submission system was first put in place. Home health agencies were required to submit assessment data for all patients who were currently under care, but the rule requiring an RFA 01 for an initial record was waived for patients who were currently under care on the startup date.
jHAVEN User Tool Search

The search feature is available for the following:

- Assessments
- Branches
- Patients

All these search features all function in the same manner. The difference is in how they are initiated.

Assessment Search

Initiate the Search

Select the Search option from the Assessment drop down on the Menu Bar and the Assessment Search Screen displays.

1. The Assessment Search screen displays.
Use No Criteria

1. If no criteria are to be used, move past the Search Criteria rows, and click the Search button.

2. All the Records found in the database will be returned. The exception would be any Patient or Assessment associated with a Patient marked as “Yes, Hide Patient”. These will not be included. See Show Hidden.

Use Specific Criteria

1. If specific criteria can be used to narrow the search, add it into the Search Criteria rows using Field Name, Condition, and Field Value.

   a. Text Fields:
      i. Fields requiring the User to enter data into the Field Value.
      ii. Conditions for Text fields will be: Contains, Equal To, and Not Equal To.
   
   b. Fix Value Fields:
      i. Fields requiring the User to select an option for a dropdown for the Field Value.
ii. Conditions for Text fields will be: Equal To and Not Equal To.

c. Date Fields:
   i. Fields requiring the User to enter a date into the Field Value.
   ii. Conditions for Text fields will be: Equal To and Not Equal To.

RULES:
1. If one of the criteria fields is used, all three (3) must be used.
2. Text fields and date fields will require the user to enter data into the Field Value field.
3. Fixed value fields will require the user to select a value from a drop down list.

2. Click the Search button.

Note: Clicking the Search button after entering the search criteria will display only the results that match all the search criteria.

Clear Search Criteria

Click the Clear button to remove all search criteria.
**Show Hidden**

Selecting the checkbox next to Show Hidden will include assessments for Patients marked ‘Yes, Hide Record’ on the Patient screen.

Unchecking this box will eliminate all Patients that have been hidden.

**NOTE:** The Branch Screen does not contain the “Show Hidden” Checkbox. It is not applicable to the Branch Data.

**Search Summary Result**

The results of the search, whether or not criteria were used, display all the results found. This summary is sorted by the Patient’s Last Name.

The User may resort the summary by clicking on the column headers. In the following example, the summary has been sorted by the ‘State’ column.
Navigating the Search Result Summary

1. Navigating the summary is done using the arrow buttons.

   a. Begin with first 100 rows of data.
   b. Go back one page.
   c. Number of records returned and which are currently displayed in the summary.
   d. Go forward one page.
   e. Go down to the last group of 100 rows in this result.
   f. View All

Assessment Search for Only One Specific Patient

Often it is faster and more efficient to find all the assessments for one single patient. This can be done directly from the Patient Screen using the ‘View Assessments’ feature. For detail how to do this, see Locate Assessments from the Patient Screen.
Branch AND Patient Searches

The search for the Branch and Patient screens is included in those Administration screens.

- Select the Branch option from the Administration drop down on the Menu Bar and the Branch Screen displays.
- Select the Patient option from the Administration drop down on the Menu Bar and the Patient Screen displays.

These Administration screens include the search in the top portion of each of their screens. The example shown below is using the Patient Screen. The Branch Screen is similar.
Master Data (Administration Screens)

Before any assessments can be created, a basic set of Master Data is required. This data consists of
Agency data, User data, Branch data and Patient data. It is entered into jHAVEN via the Administration
Screens.

Administration Screens – Common Features

The Administration Screens are used to capture master data. That is, the Agency, Branch, User and
Patient data, which will support the Home Health Agency Assessments.
jHAVEN contains the following familiar Windows features.

Title Bar
Displays the name of the software, jHAVEN and the software version.

Menu Bar
Drop down lists on the menu bar contain command selections based on user roles and the open screen.
See User Roles Access Table.

Utilizing the Alt key on the keyboard will place the cursor in the menu bar.
By using the arrow keys on the keyboard, users can navigate through the selections on the menu bar.

For example: On the Assessment Search screen, if the cursor is on the File menu item, pressing the right
directional arrow will move the cursor to the Administration menu item. Pressing the up and/or down
directional arrows will navigate through the drop down menu list.

Tool Bar
Each screen contains a tool bar that displays various buttons and icons to assist the user. Holding the
mouse over the icons will display the name of the functionality. The availability of the icons will vary
depending upon the user role and the Administration screen displayed (active).

Administration Screen Tabs
Tabs for any open Administration screens will display. An asterisk (*) next to the name on the tab means
there are changes that need to be saved.
Various screens are divided into multiple sections. Sections displayed are dependent upon the type of screen.

The Agency screen is divided into:
- Summary
- Detail
- Agent Information

The User screen is divided into:
- Summary
- Detail
- Activation
- Agency
The Branch screen is divided into:
- Search Criteria
- Summary
- Detail
- Contact Person
- Action

The Patient screen is divided into:
- Search Criteria
- Summary
- Detail
- Actions

Each section can be collapsed, as illustrated in the above screen shots, by use of the arrow to the left of the section title. Clicking on the arrow a second time will expand the section.

Some sections may also be resized if needed by placing the cursor over the line that separates the sections. The cursor will create an arrow. Click and drag the line to either the right or left depending on which area the user wants to expand. Columns in the Summary section can be resized by clicking and dragging on the line between headings.

The Agency screen documents the basic information about the Agency. The jHAVEN tables are now capable of supporting multiple agencies, which are identified as unique entities by using unique Agency IDs plus the Agency State Code.
Agency Screen – Add & Maintain an Agency

Agency Screen – Create An Agency

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The Agency screen allows users, to setup, modify and delete agencies. The term “Agency” refers to a Home Health Agency.

Complete the following steps to create a new Agency.

1. Select the Agency option from the Administration drop down on the Menu Bar.

2. Enter detail agency information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
3. After agency details are entered, click the Save icon.
   a. If Accessibility is on, The Save Agency Options pop-up window displays.
      i. Save and Close
      ii. Save and Continue
      iii. Cancel

4. The Informational Message displays to confirm that the agency has been saved.

5. Saved agency information will display in the Agency Summary section on the left side of the screen.

6. To continue on this screen and add additional agencies, click the New icon.
7. Enter data and click the Save icon.
NOTE: Edits are performed during the data entry process and, if remain at the time the Agency is saved, the errors are summarized in a pop-up window.

Agency Screen - Modify an Agency

Complete the following steps to modify an existing agency.

1. Locate and highlight the agency in the summary section.

   2. Make the appropriate changes on the right side of the screen.

   3. Click the Save icon.

Agency Screen – Special Functionality

Effects of Modifying the Agency ID Field

The User may modify the Agency ID in an existing Agency. When this is done through the Agency screen, the following activities occur within all the Administration Screens.

- Any User that has been associated with the original Agency ID will be re-associated with the NEW Agency ID.
- If there are Branches associated with the original Agency ID, the Branch will be re-associated with the NEW Agency ID.
• If there are patients associated with the original Agency ID, those Patients will be re-associated with the NEW Agency ID.

• If there are assessments associated with any patient that has been re-associated with an updated Agency ID, when these assessments are re-opened, a Decision Message will be displayed.

**Agency Screen - Delete an Agency**

Complete the following steps to delete an agency.

1. Locate and highlight the agency in the summary section.

2. Click the Delete icon.

**RULES:**

1. An Agency cannot be deleted if patients have already been created under that agency.
2. An Agency with no CCN will be rejected by the ASAP system.
3. A Branch is a satellite of an Agency. Any branch must be tied to an agency.
User Screen – Add & Maintain a User

User Screen - Create a User

There must always be at least one active System Administrator. It is highly recommended that there be at least two System Administrators.

For optimization of the skip patterns and/or edits, it is recommended that data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

The User screen allows users, based on User Roles Access Table, to setup new users, modify users and delete users.

Complete the following steps to add a new user.

1. Select the User option from the Administration drop down on the toolbar.

2. The User screen displays.
3. Enter user information into the User Detail section. Required fields display on the screen in bold type with an asterisk.

![User Detail](image)

1. Enter the Agency Detail. User must select an Agency to which this User will be associated.

![Agency Detail](image)

2. Branch is not required. However, the user will get a warning message if no branch association is selected.

![Agency Detail](image)

a. Branch Option will be:
   i. [P] = Parent Agency. This user is not associated with a specific Branch, but is associated with the agency (the parent) that was selected.
   ii. [N] = The agency selected has no branches at this time.
iii. 10-character Branch ID = This use is specifically associated with a specific Branch.

RULES:
1. The 10-character Branch ID will only be listed under ‘Branch’ if the System Administrator has already entered that Branch into the jHAVEN database.
2. After user information has been entered, click the Save icon. Saved user information will display in the User Summary section on the left side of the screen.
3. To add additional users, click the New icon.
4. Enter data and click the Save icon.

User Screen - Modify a User

Complete the following steps to modify an existing user.
1. Access the User Screen.

![User Screen Screenshot]

2. Locate and highlight the user in the summary section.
3. Make the appropriate changes under the User Detail panel, on the right side of the screen.
4. Click the Save icon.

NOTE: The User ID field cannot be modified once the user is saved.

Termination Date
A Termination Date should only be entered if an active user is no longer valid (e.g., no longer works for the agency).
If a Termination Date is entered, a Termination Date message box displays advising pending assessments should be reassigned to an active user.

User Screen - Delete a User

Complete the following steps to delete a user.

1. Locate and highlight the user in the summary section.
2. Click the Delete icon.

RULES:

1. Deletions cannot be made if user has created or modified any assessments.
2. A Termination Date should only be entered if an active user is no longer valid (e.g., no longer works for the agency).
Branch Screen – Add & Maintain a Branch

The Branch screen allows users to add, edit, delete and search for Branches. To access the Branch Screen select the Branch option from the Administration drop down on the menu bar.

Branch Screen – Create a Branch

Branches may be added to the jHAVEN application after the Branch ID has been assigned by the CMS State Agency and forwarded on the User. Only System Administrators may add Branch records.

Complete the following steps to add a new Branch:
1. Display the Branch Screen.
2. Enter Branch information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
a. Agency ID (Parent of this Branch)
b. Branch ID Format
   i. Characters 1 – 2 = numeric State Code of the Agency with which this Branch is associated.
   ii. Character 3 = ‘Q’
   iii. Characters 4 - 7 = last 4 numbers in the Agency’s CCN.
   iv. Characters 8 - 10 = a sequential number 001 – 999.
c. Branch State

3. After branch information has been entered:
   a. Click the Save icon in the Tool Bar
   OR
   b. Click the Save Branch option in the File drop down options
   OR
   c. Click the ‘Add Branch’ button at the bottom of the screen.

4. Saved Branch information will display in the Branch Summary section.
5. To add additional Branches
   a. Click the New icon or the Add Branch button.
   b. Enter data and click the Save icon.
   OR
   c. Click the ‘Add Branch’ button at the bottom of the screen.

**Branch Screen - Search**

See [jHAVEN User Tool Search](#).

**Branch Screen - Modify a Branch**

Complete the following steps to modify an existing Branch.

1. If a specific branch, or set of branches is required, Search. See [jHAVEN User Tool Search](#).
2. Locate and highlight the Branch in the summary section.
3. Make the appropriate changes on the right side of the screen.
4. Click the Save icon.
5. The branch data will be saved.

**Branch Screen – Special Functionality**

**Effects of Modifying the Branch ID and/or Branch State**

The User may modify the Branch ID and or the Branch State in an existing Branch. When this is done through the Branch screen, the following activities occur within all the Administration Screens and Assessments.
• Any Agency that has been associated with the original Branch ID will be re-associated with the NEW Branch ID and NEW Branch State, if modified.

• Any User that has been associated with the original Branch ID will be re-associated with the NEW Branch ID and NEW Branch State, if modified.

• Any NON-exported assessment associated with the original Branch will be automatically updated with the NEW Branch data at the time this data was saved.

**Branch Screen - Delete a Branch**

Complete the following steps to delete a Branch.

1. Locate and highlight the Branch in the summary section.

2. Click the Delete icon
   OR
3. Click the ‘Delete Branch’ button at the bottom of the screen.
RULES:
1. Only System Administrators may delete Branch records.
2. A Branch cannot be deleted if it has been associated with a User.
3. A Branch cannot be deleted if one or more assessments have been created using that branch.

Sample Messages:
The following sample is generated when the association is with an active User.

![Image of sample message]

The following sample is generated when the association is with an Assessment.
You cannot delete the branch 00Q112222 VI because it is associated to the following assessment(s).

<table>
<thead>
<tr>
<th>Patient Name</th>
<th>Correction #</th>
<th>Assessment Type</th>
<th>Status</th>
<th>Assessor</th>
<th>Effective Date</th>
<th>Export Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient01</td>
<td>00</td>
<td>8 - Death at home</td>
<td>COMPLETE</td>
<td>admin</td>
<td>01-01-2010</td>
<td>01-01-2010</td>
</tr>
</tbody>
</table>
Patient Screen – Add & Maintain a Patient

The Patient screen allows users, to add, edit, delete and search for Patients. To access the Patient Screen select the Patient option from the Administration drop down on the menu bar.

Patient Screen – Create a Patient

Patients may be added to the jHAVEN application after the Patient ID has been assigned by the CMS State Agency and forwarded on the User. Only System Administrators may add Patient records.

Complete the following steps to add a new Patient:

1. Display the Patient Screen.

See following pages for screen shots.
Additional Patient detail sections follow.
### Patient Detail * = Required Field (Alt+1)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency ID*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient ID Number (M0020)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient First Name (M0040)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Middle Initial (M0040)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Last Name (M0040)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Suffix (M0040)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient State of Residence (M0050)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Zip Code (M0060)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Medicare Number (M0063)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Medicare Number (M0063)</td>
<td></td>
<td>NA - No Medicare</td>
</tr>
<tr>
<td>Social Security Number (M0064)*</td>
<td></td>
<td>UK - Unknown or Not Avail</td>
</tr>
<tr>
<td>No Social Security Number (M0054)</td>
<td></td>
<td>NA - No Medicaid</td>
</tr>
<tr>
<td>Medicaid Number (M0065)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Medicaid Number (M0065)</td>
<td></td>
<td>NA - No Medicaid</td>
</tr>
<tr>
<td>Birth Date (M0065)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gender (M0069)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>National Provider Identifier (NPI) (M0018)*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NPI Unknown or Not Available (M0018)</td>
<td></td>
<td>UK - Unknown or Not Avail</td>
</tr>
<tr>
<td>State Provided Patient ID (if applicable)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2. Enter Patient information into the appropriate fields. Required fields display on the screen in bold type with an asterisk (*).
   a. Agency ID (Parent of this Patient)

3. After Patient information has been entered:
   a. Click the Save icon in the Tool Bar
      OR
   b. Click the Save Patient option in the File drop down options
      OR
   c. Click the ‘Add Patient’ button at the bottom of the screen.

4. Saved Patient information will display in the Patient Summary section.
   a. Left portion of Summary
b. Right portion of Summary

![Image of patient data table]

5. To add additional Patients,
   a. Click the New icon or the Add Patient button.
   b. Enter data and click the Save icon. OR
   c. Click the ‘Add Patient’ button at the bottom of the screen.

![Image of action buttons]

Patient Screen - Search

See jHAVEN User Tool Search for all searches required based on patient data found on the Patient Screen.

Locate Assessments from the Patient Screen

If a System Administrator or a Data Entry User needs to see all the Assessments associated with a specific Patient, they may do so using the ‘View Assessments’ feature.

Complete the following steps to see a list of all the assessments for a specific patient.
1. Open the Patient Screen.
1. Do a Patient Search to locate the patient whose assessments are to be viewed.

   NOTE: There are two sample screen shots that follow. The first (2a) illustrates using the ‘View Assessments’ button without selecting any search Criteria on the Patient Search. The second (2b) illustrates using the ‘View Assessments’ button with Search Criteria being used on the Patient Search.
a. The Patient Search button was used to get all the patients associated with this user. They are viewed here in the Patient Summary. No Search Criteria has been used, so all Search Criteria fields are blank.

b. The user entered search criteria on the Patient screen before using the Search button. Only those patients associated with this user AND fitting the search criteria were returned in the result; viewed here in the Patient Summary. The user will be able to highlight only one of the two patients listed in this summary.
2. Highlight the specific patient’s row from the Patient Search Summary.
3. Click the ‘View Assessments’ button.

4. The Assessment Search will be initialized. When all the assessments are located for the one patient selected, they will be displayed in the Assessment Search Summary.

   a. Using either cases illustrated in 2a and 2b above, NO search criteria is shown in the Assessment Search Criteria fields. If search criteria was used in the Patient Search on the Patient Screen, it is not brought over into the Assessment Search screen.

   Note: The Patient Search Criteria is NOT used in the Assessment Search for Assessments.
b. The Assessment Criteria fields. If the Assessment Search Screen was already an inactive open screen AND previously had Assessment Search Criteria entered, that previously entered data would still be seen in the Assessment criteria fields. Although, it does NOT reflect the data in the Summary from the Patient’s assessments search.
5. The user may continue with their activities using the Assessment Search Summary data.
Patient Screen - Modify a Patient

Complete the following steps to modify an existing Patient.

1. If a specific Patient, or set of Patients, is required, use the jHAVEN User Tool Search.
2. Locate and highlight the Patient in the summary section.
3. Make the appropriate changes on the right side of the screen.
4. Click the Save icon.
5. The Patient data will be saved.

Patient Screen – Special Functionality

Effects of Modifying Patient Data

The User may modify the Patient data in an existing Administration Patient screen if there are assessments associated with any patient whose data has been updated, when these assessments are re-opened, a Decision Message will be displayed.

The User must determine whether to allow the assessment to be updated with the new patient data, or not.

Move a Patient from One Agency to Another Agency

A patient is assigned to an agency via the Administration Patient Screen. Each patient must be associated with an Agency at the time the patient is added into jHAVEN.

RULES:

1. To move a Patient form one Agency to another, all the existing assessments, created under the existing Agency, must be exported.

First review this patient’s assessments and export any assessments that have NOT been exported. See Exporting Assessments for Submission into ASAP.

If there are non-exported assessments still for the Patient the user wishes to move, the following message will display.
Complete the following steps to move a patient from one agency to another agency.

1. Open the Patient screen and locate the patient to be moved.

2. Highlight the Patient to be moved.

3. Modify the Agency ID.

4. Click the Save icon to save the Patient.
5. Review the Patient Summary.
   a. Look for the patient that was moved. Because this patient had exported assessments, there will be:
      i. One row associated with the original Agency ID AND with the exported assessments and
      ii. A second row associated with the new Agency ID and no assessments.

See the next page for a screen shot of the Patient Summary for patient ‘Pat02’.

NOTE: If the Patient to be moved has NO ASSESSMENTS, then there will only be one (1) row in the Patient Summary. There were no exported assessments to be associated with the Patient’s original Agency ID.

**Patient Screen - Delete a Patient**

Complete the following steps to delete a patient.

1. Locate and highlight the patient in the summary section.
2. Click the Delete icon.
   OR

3. Click the 'Delete Patient’ button.
4. If Accessibility is NOT turned on, the Patient will be deleted and the Patient Screen will be closed.
   OR

5. When Accessibility is turned on, the ‘Delete Patient’ Message pop-up displays.
   a. Select the desired action button. See screen shot that follows.

   ![Delete Patient Pop-up]

   b. Delete and Close
   c. Delete and Continue
   d. Cancel

6. The pop-up window closes.

RULES:
1. A patient cannot be deleted if one or more assessments have been created for the patient.

If the Patient has an assessment:
1. Pop-up Window displays.
2. Click ‘Cancel’ button to stop the delete.
3. Will be returned to the Patient screen.

Assessments

Create an Assessment

To create an assessment the following must already be accomplished or available:
- Successful Login
- Existing Administration Data: Agency, User, and Patient

Select a Patient

Complete the following set to create an assessment:
1. Select the Patient option from the Administration drop down on the toolbar.
2. The Patient Screen displays.
3. Search for a patient or add a new patient.

4. A Patient was found and displays in the summary section of the patient Screen.
<table>
<thead>
<tr>
<th>Field Name</th>
<th>Condition</th>
<th>Field Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency ID</td>
<td>Equal To</td>
<td>Home Health Agency (01 - HH4021_1DA)</td>
</tr>
<tr>
<td>Patient ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td>First Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Middle Initial</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient ID Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient First Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Middle Initial</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Last Name</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Suffix</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient State of Residence</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Patient Zip Code</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Patient Summary (Alt+L)**

<table>
<thead>
<tr>
<th>Patient ID</th>
<th>First Name</th>
<th>Middle Initial</th>
<th>Last Name</th>
<th>Agency ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>P2</td>
<td>FIrstName</td>
<td>MIdleInit</td>
<td>LastName</td>
<td>HH4021</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>01</td>
</tr>
</tbody>
</table>

**Patient Detail (Alt+J)**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency ID</td>
<td>P2</td>
</tr>
<tr>
<td>Patient ID Number</td>
<td>P0020</td>
</tr>
<tr>
<td>Patient First Name</td>
<td>PIrstName</td>
</tr>
<tr>
<td>Patient Middle Initial</td>
<td>MIdleInit</td>
</tr>
<tr>
<td>Patient Last Name</td>
<td>LLastName</td>
</tr>
<tr>
<td>Patient Suffix</td>
<td></td>
</tr>
<tr>
<td>Patient State of Residence</td>
<td>10 Iowa</td>
</tr>
<tr>
<td>Patient Zip Code</td>
<td>50250</td>
</tr>
</tbody>
</table>
Launch the Assessment Wizard

The Wizard is a pop-up window used for creating all assessments.

5. In the Patient Summary section, double click on a patient or highlight a patient (click on it) and click the Add Assessment button at the bottom of the Patient Detail column.

6. The Add Assessment Wizard Pop-up window is displays.

7. Select the OASIS Specification time period based on the anticipated Completion Date (M0090).

   NOTE: If the incorrect time period is selected, the assessment will need to be deleted and re-keyed.

8. Select the type of assessment.
9. The Finish button is enabled. Click Finish to continue to the Assessment screen.

NOTE: After clicking Finish, errors and/or warning messages, if applicable, will display in a pop up screen.

10. The Assessment Screen displays.

**The Assessment Screen**

The assessment screen automatically displays.

Tabs for any open Administration Screen will display below the toolbar at the top of the screen under the Assessment. When the Assessment screen is active, no other screen may be accessed. When a user tries to view one of the Administration screens:

1. An error message displays.

2. Click OK to close the error.
3. User is returned to the Assessment screen.
Assessment Details – Screen Sections

The specific Assessment tab displays the assessment type and patient name.
**Navigator**

The Navigator is on the left side of the assessment screen and labeled as such.

The navigator is a collapsible “tree”, which list all the assessment categories and the assessment questions under each of these.

The fields for the questions that require answers are in bold. As questions are answered, they are removed from the tree.

The Show/Hide Answered Questions icon in the toolbar at the top of the screen will also change the display of the tree.
Clicking on an item in the tree will directly place the cursor in the selected field.

**Edits List**

The Edit section is located on the bottom left corner of the assessment screen.

The errors and warnings are found in the display area.
Clicking on an edit message will move the cursor within the assessment to the appropriate field.

Some errors will present a pop up message, during the data entry process, and must be addressed at the time you are displayed, in order to proceed. These edits will not display in the Edits listing.

**Assessment Data Tabs**

There are four (4) tabs directly associated with the Assessment located on the top right side of the assessment screen.

- Assessment
- Patient Details
- Agency Details
- Assessment Determination
**Assessment Tab**

This section will be the section used for the actual assessment questions and answers. This is where data entry is accomplished.
Patient Details Tab

Patient data is displayed in a view only, non-editable, format.
Agency Details Tab
Agency data is displayed in a view only, non-editable, format.

Assessment Determination

This Assessment is Currently Being Completed for the Following Reason (M0100) Start of care
Data Entry into the Assessment

When the assessment is first open after the ‘Add Assessment Wizard’ is completed, there are various data fields, which pull their data from the Administration Screens. These are pre-populated and may not be changed within the assessment, with ONE exception. The exception is the Payment Source.

The Payment Source (M0150) data will be populated from the Patient Screen when the assessment is created. Further changes to this field, on the Patient Screen, will NOT be populated, and therefore not reflected, in the assessment at any later time.

The Payment Source (M0150) may be changed within the assessment itself. This allows the user to set the payment source for a patient specifically for each assessment regardless of how it is set on the Patient screen.

TIPS: For optimization of the skip patterns and/or edits, it is recommended that assessment data be entered in the order the questions appear on the screen. Entering data out of order can cause unexpected results.

Enter data in each field and use the “Tab” key on the keyboard to navigate from field to field. This allows skip patterns and edits to be appropriately applied and helps ensure all fields are addressed.

The User will not be able to enter different of additional data in these fields, with the EXCEPTION of the Branch ID data field (M0016).

The Branch ID field may be changed using the dropdown options provided. The Branch State is automatically pulled from the Administration Branch Screen for the specific Branch ID selected.

Complete the following steps to complete data entry into the assessment. Data Entry may be complete all in one sitting, or spread out across several.

1. Enter applicable data into the assessment beginning at the top of the Assessment tab.

2. Pop-up edit messages must be addressed as they are displayed before continuing on with the data entry field. These edits will not display in the Edits listing in the lower left portion of the screen.

3. Edit Messages, Errors and Warnings
a. Errors and warnings found on the data, display in the lower left of the screen in the ‘Edit’ section of the assessment.

RULES:
1. Error edits must be corrected before the assessment can be Exported.
2. Warning edits provide only a warning. It is up to the user to enter the data appropriately. Warning Edits would not stop the assessment to be exported.

NOTE: For the system to calculate HIPPS values for the assessment, the following data fields must be completed; questions answered.

4. There are two options for saving this data.
   a. Click the Save icon.
   b. Click the Save and Validate icon.

Save

TIP: Before closing an assessment – SAVING - always tab forward off the last field entered. This will ensure that that last field is saved.

When a ‘Save’ is selected for an assessment, the data is simply saved. It is NOT validated. The status of the Assessment will be set to “IN_USE”. Once the data has been saved, the user may then close the assessment.
This assessment may be re-opened at a later time for more data entry or for the ‘Save & Validate’ process. See Editing/Modifying an Assessment.

Save & Validate
The following process occurs when ‘Save & Validate’ icon is selected.

1. The appropriate Data Specification, selected when assessment was created, is loaded.

2. The data is verified and validated using the jHAVEN VUT.

3. If there are no errors, the assessment will become ‘EXPORT_READY’.

4. If errors and/or warnings are found, they will be identified and provided in the ‘Edits’ list.
5. Even when errors are found, the Assessment is saved.
6. User may continue editing and adding data to the assessment and ‘Save & Validate’ again.
   OR
7. The User may choose to simply close the assessment “as is”.

Print the Error Report
To print the Assessment Error Report:

1. Click the Print Error Report button below the Edits section
   OR

2. Click the Print Assessment Error Report icon on the toolbar.
3. The Report Viewer displays the report.
**Assessment Error Report**

**Assessment Type:** 1 - Start of care, further visits planned  
**Assessment Date:** 02/25/2014  
**Last Name:** PLName02  
**Effective Date:**

<table>
<thead>
<tr>
<th>Question</th>
<th>Severity</th>
<th>Error Number</th>
<th>Error Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>M0030_START</td>
<td>Edit Error</td>
<td>-3070</td>
<td>Invalid value for this item. It is a valid YYYYMMDD date value and it is not a valid alternative value as specified in the Data Specifications. [null]</td>
</tr>
<tr>
<td>M0030_ROC_DT</td>
<td>Edit Error</td>
<td>-3460</td>
<td>If M0030_ROC_DT NA=0, then if M0030_ROC_DT is active it must not equal [9].</td>
</tr>
<tr>
<td>M0030_ROC_DT</td>
<td>Edit Error</td>
<td>-3750</td>
<td>If M0100_ASSMT_REASON=0, then M0030_ROC_DT NA must be [1].</td>
</tr>
<tr>
<td>M0080_ASSES</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M0102_PHYSN</td>
<td>Error</td>
<td>-3580</td>
<td>If M0102_PHYSN_ORDR_DGCROC_DT=0, then if M0102_PHYSN_ORDR_DGCROC_DT NA is active it must equal [1].</td>
</tr>
<tr>
<td>M0104_PHYSN</td>
<td>Error</td>
<td>-3560</td>
<td>If M0102_PHYSN_ORDR_DGCROC_DT=0, then if M0104_PHYSN_RFRL_DT is active it must not equal [3].</td>
</tr>
<tr>
<td>M0110_EPISODE</td>
<td>Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_JPP</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_IRF</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_LT</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_LT</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_NO</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_CT</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_PS</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1000_DC_SN</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1016_CHGRE</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1016_PRIOR</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
<tr>
<td>M1016_PRIOR</td>
<td>Edit Error</td>
<td>-3060</td>
<td>Only the values listed in the &quot;Item Values&quot; table of the Detailed Data Specifications Report may be submitted for this item.</td>
</tr>
</tbody>
</table>

[ ] = Not Assessed, [ ] = Skipped
Close the Assessment

**TIP:** Before closing an assessment – SAVING - always tab forward off the last field entered. This will ensure that that last field is saved.

Close the assessment by:

1. Click the ‘X’ on the corner of the Assessment Tab

OR

2. Click the ‘Close Assessment’ option under the File Menu.

3. The Assessment closes.

Opening an Existing Assessments

There are different procedures to follow when open different assessments with various ‘Statuses’. Once the desired Assessment is listed in the Assessment Search Summary, highlight it and double click to open it. Based on the Status of this assessment, follow the steps indicated in the following sections.

### Opening an Existing NON-EXPORTED Assessment

All User Roles may open any assessment that appears in the Assessment Search Summary, with which that user is associate. However, the View Only User may only view the assessment. They have no access to update the assessment in any way.

**NOTE:** System Administrators may open any and all Assessments.

Assessments in the following statuses may be opened and edited as many time as necessary before being exported.

- NEW
- IN_USE
- DATA_ENTRY
- EXPORT_READY
- COMPLETE
Complete the following steps to edit an existing assessment.

1. Search for the desired assessment (see jHAVEN User Tool Search section).
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.
3. The Assessment screen opens for editing.
4. Edit the assessment if applicable.
5. If changes are made, click the Save and Validate icon on the toolbar.
6. Close the assessment.

Administration Screen Data Has Changed
When the Administration Data is modified AND it is associated with an assessment, it will not be reflected in that assessment at the time the data was actually modified using an Administration Screen. Only when the assessment is opened by a user with access to update an assessment, in the edit mode, will the user be asked if their wish to have that assessment updated with the new data.

NOTE: The User will continue to get this Decision Message until the user answers it with the “Yes” option.

Agency
The Agency data fields, affecting the Assessment, are reflected on the Agency Details tab on the Assessment screen.

If the user says, “yes”, then the application will pull the administration data into the assessment.
**Branch**

Branch data fields are reflected within the Assessment as soon as they are modified on the Administration Branch Screen. Therefore, there will be no Decision Message for Branch data.

**Patient**

The Patient data fields, affecting the Assessment, are reflected on the Patient Details tab on the Assessment screen.

**User**

The User, if terminated, using the Termination Date on the Administration User Screen, will display a message.

**Opening An EXPORTED Assessment**

Only a user with a System Administrator role may edit an assessment that has been exported.
Complete the following steps to edit an existing assessment with a status of EXPORTED.

1. Search for the desired assessment.
2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.
3. The Exported Assessment message box displays.

![Exported Assessment Message Box](image)

4. User has 4 options and must select one of them or Cancel the open.
   a. ‘Open this assessment in read only mode’
      i. Assessment opens and displays all previously selected answers from the assessment in a view only, non-editable format.
   b. ‘Create a correction record’
      i. Assessment opens and displays all previously selected answers from this assessment.
   c. ‘Create an inactivation record’
      i. The Inactivation Assessment opens. All fields are a view only, non-editable format. Once saved, the Reason For Assessment (RFA) Type will be changed to XX-Inactivation.
   d. ‘Reset Status and Edit’
      i. Discharge Assessment opens and displays all previously selected answers from admission and discharge in an editable format. All fields are editable except the Admission Date (12).

   TIP: Use the Help button to review the options as they were originally in Classic HAVEN.

5. Once an option is selected, click ‘OK’.
6. The assessment will open.
7. Edit the assessment if required.
8. If changes are made, click the Save and Validate icon on the toolbar.
9. Close the assessment.
Opening an Inactivated Assessment

Complete the following steps to copy an inactivated assessment with a status of EXPORTED. These will start with an Assessment Type of XX- Inactivation. Only one copy per inactivated assessment is allowable.

1. Search for the desired assessment (see jHAVEN User Tool Search section).

2. Double click on the desired assessment or click once on the desired assessment and click the Edit Assessment button at the bottom of the page.

3. The Exported Assessment message box displays.

4. User has 3 options
   a. ‘Open this assessment in read only mode’
      i. Inactivation Assessment opens and displays fields in a view only, non-editable format. This selection checks the View Only checkbox at the bottom of the Assessment Search screen. All other assessments will be view only until this box is unchecked.
   b. ‘Create a copy record’
      i. A new Assessment opens and displays all previously selected answers from the most current inactivated record. If a copy has already been made from this inactivation assessment, this option will NOT be available.
   c. ‘Reset Status’
      i. The status of the assessment is also reset to EXPORT_READY, if assessment was Saved and Validated and is without errors.
      OR
      ii. The status of the assessment is also reset to IN_USE, if assessment was closed without saving.

TIP: Use the Help button to review the options as they were originally in Classic HAVEN.

5. Once an option is selected, click ‘OK’.
6. The assessment will open.
7. Edit the assessment if required.
8. If changes are made, click the Save and Validate icon on the toolbar.
9. Close the assessment.
Editing/Modifying an Assessment

1. Locate desired assessment using the jHAVEN User Tool Search.
2. Add/Modify assessment data using same methods used when adding a new Assessment.
3. Click the Save and Validate icon on the toolbar.
4. Close the assessment.
   a. Click the ‘X’ on the assessment tab.
   OR
   b. Click the option under the File Menu of Close assessment.

Viewing an Assessment in View Only Mode

Complete the following steps to open an assessment in view only mode.

1. Search for the desired assessment using the jHAVEN User Tool Search.
2. Check the View Only checkbox at the bottom of the screen.
3. Double click on the desired assessment select the desired assessment and click the View Assessment button at the bottom of the screen.
4. The Assessment screen opens in view only mode.
5. An assessment in view only mode cannot be modified. If this assessment is closed and the user tries to open another assessment from the Search screen, it will be displayed as view only also. The user will need to uncheck the View Only checkbox before opening the assessment to make changes to it.
Delete An Assessment

RULES:

1. Only a user with a System Administrator role may delete an assessment.
2. Assessments with a status of EXPORTED cannot be deleted.

Complete the following steps to delete an assessment.

1. Search for the desired assessment using the jHAVEN User Tool Search.
2. Click once on the desired assessment.
3. Click the Delete Assessment button at the bottom of the Assessment Search screen to delete the selected assessment.
4. The ‘Confirm Assessment Delete’ message displays.
5. Click OK to delete the assessment.

NOTE: Click Cancel to close the message and not delete the assessment
Exporting Assessments for Submission into ASAP

EXPORT RECOMMENDATION: The application is now encrypted. The encryption within the application is federally required. You may experience some slowness while using export feature. It is strongly recommended to export assessments in small batches and should be done frequently to optimize the application at its best capacity.

The Export Assessments screen allows the user to determine what data is to be exported. There are two (2) options for the types of exports. The screens for the two options are different.

- New Exports
- Previous Exports

To initiate the Export screen, select the Export option from the Import/Export drop down on the toolbar.

New Exports
Complete the following steps to export an Assessment, after the Export Type of ‘New Export’ has been selected from the drop down.

1. Select the Export Path. This field is required. This is the location where the exported files will be stored.
   a. Click on the Browse button to navigate to the location where the files will be exported.
   b. Locate the folder and click ‘OK’.

   **NOTE:** Once the Export Path is established in jHAVEN, that path will become the DEFAULT until it is changed again.

2. Enter an ‘Export Name’ for this exporting process.
3. Enter an ‘Export Description’ for this exporting process.
4. Review the ‘Assessments to be Included in the Export’. Check the check box in front of all these assessments to be included.
   a. User may use the ‘Select All’ icon, which will place check marks in all the check boxes for all the assessment listed.
   b. User may use the ‘Clear All’ icon, which will remove check marks in from all the check boxes for all the assessment listed.
5. The user may run the ‘Error Check’ on the assessment(s).
a. Check the checkbox in front of the assessment(s). Click the ‘Error Check icon [Error Check].

b. The Status Report displays.

c. Select the ‘Save to File’ button [Save to File] to save the error report (.txt).

6. Click the ‘Export’ icon [Export] to begin the exporting process.

NOTE: Any assessments that do not have checks in the check boxes in front of the Patient Name will NOT be included in the export.
7. The files are ready for submission to the national database.

Previous Export

1. After selecting the ‘Export Type’ of Previous Export. Locate the ‘Export Path’. Click on the Browse button to navigate to the location where the files will be exported.

2. Enter the Export Name.
3. Select the Export Description. This field can be used to document details regarding the export.

4. A list of assessments available to be exported is displayed.

5. Select/highlight a ‘Previous Export’.

6. A list of assessments available to be exported is displayed. A minimum of one selection is required.

7. A Loading Data Specs message displays. This process loads the submission data specifications to be used by jHAVEN for data validation of assessments during import. The assessments are compared to the submission edits.

8. The Export complete message displays to notify the user the process is complete.
   a. The location of the exported files displays in parenthesis at the end of the message.

9. The files are ready for submission to the national database.
**Action Buttons on the Export Screen**

The action Buttons at the bottom of these screens will provide the following functions.

**Left Side**

At the bottom of the export screen, on the left-hand side of the screen, are two (2) icons.

1. The Select All button will select all assessments displayed in the list to be included in the export file.

2. The Clear Selection button will unselect all assessments previously selected.

**Right Side**

At the bottom of the export screen, on the right-hand side of the screen, are three (3) icons.

1. If desired, select the Print Assessment List button to print a list of assessments included in the file to be exported.

   **NOTE**: When this report is generated, it does not display on the screen. The user must print it.

2. Select the Error Check button to validate and/or check for errors on all previously selected assessments. Error results display in a new screen.

3. Select the Export button to export selected assessments for submission.
Import Data From Outside Source

IMPORT RECOMMENDATION: The application is now encrypted. The encryption within the application is federally required. You may experience some slowness while using import feature. It is strongly recommended to import assessments in small batches and should be done frequently to optimize the application at its best capacity.

The Import Assessments screen allows the user to determine how data is imported.

Complete the following steps to import an assessment.

1. Select the Import option from the Import/Export drop down on the toolbar.

2. The Import Assessment screen displays.
3. Select the Location. Click on the Browse button to navigate to the location of the files to be imported.

4. Select the location from which to pull the import file.
5. If no warning message is wanted when a patient is added into jHAVEN during the import process, check the ‘Patient Data Options’ checkbox to turn off the warning message.

6. Select the options from the Miscellaneous Data Options list by checking the checkboxes in front of the options.

7. Click the ‘Select All Options’ button to check or uncheck all checkboxes.

   a. OPTIONS:
      i. “Do not display warnings in error check results.” This selection removes warning messages from the error check results report that displays after importing data. Only fatal errors are included in the report.
      ii. “Assign Exported status to assessments without errors (instead of Export Ready.)” This selection sets the status of imported assessments to Exported, if the record does not have errors.
iii. “Associate assessments with a blank agency ID field to the selected agency below.” This selection links assessments that are imported without an Agency ID to the agency highlighted in the Associate assessments with blank Agency ID’s to this agency section.

8. Select the ‘Error Check’ button to validate and/or check for errors on all assessments to be imported. Error results display in a new screen.

9. Click the Import button to import selected assessments into jHAVEN.

10. The import process begins.

11. A ‘New Patient’ message displays if the warning option is not checked.

12. Click the ‘Yes’ button to continue with the import of the assessment.

   NOTE: Clicking the ‘No’ button will cancel the importing of only this assessment. Clicking the ‘Cancel’ button will stop the import process.

13. A Loading Data Specs message displays. This process loads the submission data specifications to be used by jHAVEN for data validation of assessments during import. The assessments are compared to the submission edits.

14. An ‘Import complete’ message displays as well as a Status Report for all assessments included in the import.
15. If no files are successfully imported, the Import failed message box displays along with a Status Report.

16. Click the ‘OK’ button on the Import Complete pop-up window to view the Status Report.

17. Click on the Save to File button, on the bottom of the report, to save a copy of the report to the computer.

18. Click on the ‘X’ icon in the top right corner to close the report.
jHAVEN Application Reports

jHAVEN reports allow users to preview and print assessment information, as well as detail and summary information for both agencies and patients.

Report Viewer

The jHAVEN application reports are generated in third-party software, Report Viewer, using the this software’s ICONS and formatting. All the reports use this software in the same fashion.

Print Report

To print the report, click the Print icon on the Report Viewer screen.

Save Report

To save the report, click the Save icon on the Report Viewer screen.
Export Report
To export a report, click the arrow next to the Save icon. The available export values display.

To select an export type, use the dropdown arrow by the Save icon to select a location to export (save) the report and click Save.

Available jHAVEN Reports
Available jHAVEN Reports are:
- Event Tracking
  - Assessment Data
  - Agency
  - Branch
  - Patient
  - User
- Assessment Data Entry – By Status
- Assessment Data Entry – By Branch

Event tracking Reports
Complete the following steps to run the Event Tracking report.

NOTE: Only the System Administrator User ID can run the Event Tracking reports.

1. Select Event Tracking from the Reports drop down on the toolbar.
   a. Accessibility Off

   ![Event Tracking Screen](image)

   b. Accessibility On

   ![Event Tracking Screen](image)

3. Select Event.
   a. “Event drop down. Use up and down arrows to select an Event.”*

4. Select or enter the ‘Event Dates’.
   a. “From, Date**
   b. “To Date***
5. Select the ‘OK’ button to generate the report.

NOTE: Selecting the Cancel button will close the parameter screen; no report will be generated.


*Agency Event Tracking Report*

![Event Tracking dialog box with selected parameters: Agency, 01-03-2013 to 06-05-2014]
### jHAVEN - Home Assessment Validation and Entry System

#### Agency Event Tracking

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Agency Name</th>
<th>Agency City</th>
<th>State</th>
<th>Assigned ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>jHAVEN</td>
<td>Tue, 11 Feb 2014 19:31:58</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HHAJ1</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin1</td>
<td>Tue, 11 Feb 2014 14:32:32</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HHAJ1</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin1</td>
<td>Tue, 11 Feb 2014 14:32:32</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HHAJ1</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin1</td>
<td>Tue, 11 Feb 2014 14:36:39</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HHAJ1</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin1</td>
<td>Wed, 12 Feb 2014 08:03</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HHAJ1</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin1</td>
<td>Wed, 12 Feb 2014 08:13</td>
<td>Home Health Agency 02</td>
<td>Altoona</td>
<td>IA</td>
<td>HHAJ2</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin1</td>
<td>Wed, 12 Mar 2014 07:42:05</td>
<td>Home Health Agency 01</td>
<td>West Des Moines</td>
<td>IA</td>
<td>HHAUJ1</td>
</tr>
</tbody>
</table>
**User Event Tracking Report**

### jHAVEN User Event Tracking Report

#### 03-05-2014 thru 03-05-2014

Requested by: SysAdmin01

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Login ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>VOnly01</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>VOnly02</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>VOnly03</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>SysAdmin02</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>SysAdmin02</td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>SysAdmin02</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>SysAdmin01</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014</td>
<td>SysAdmin01</td>
</tr>
</tbody>
</table>
### Branch Event Tracking Report

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Branch ID</th>
<th>Branch Name</th>
<th>Branch City</th>
<th>Branch State</th>
<th>Agency ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014 13:35:31</td>
<td>16028586001</td>
<td>HHA01_B0001</td>
<td>IA</td>
<td>Home Health Agency 01 - HHA01(B)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014 13:36:03</td>
<td>16028586001</td>
<td>HHA01_B0001</td>
<td>IA</td>
<td>Home Health Agency 01 - HHA01(B)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014 13:36:25</td>
<td>16028586001</td>
<td>HHA01_B0001</td>
<td>IA</td>
<td>Home Health Agency 01 - HHA01(B)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014 13:36:43</td>
<td>16028586001</td>
<td>HHA01_B0001</td>
<td>IA</td>
<td>Home Health Agency 01 - HHA01(B)</td>
<td></td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014 13:37:10</td>
<td>16028586001</td>
<td>HHA01_B0001</td>
<td>IA</td>
<td>Home Health Agency 01 - HHA01(B)</td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 10:17:42</td>
<td>16028590002</td>
<td>IA</td>
<td>Home Health Agency 01 - HHA01(B)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 10:19:01</td>
<td>16028597001</td>
<td>IA</td>
<td>Home Health Agency 02 - HHA02(B)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

FOR OFFICIAL USE ONLY - PRIVACY ACT INFORMATION CONTAINED HEREIN.
### Patient Event Tracking Report

**jHAVEN - Home Assessment Validation and Entry System**

**Patient Event Tracking**

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Last Name</th>
<th>First Name</th>
<th>SSN</th>
<th>Birth Date</th>
<th>Hide Patient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>SysAdmin01</td>
<td>Wed, 5 Mar 2014 07:21:28</td>
<td>PUHame03</td>
<td>PIFname03</td>
<td>599-96-8898</td>
<td>02-10-1910</td>
<td>0</td>
</tr>
</tbody>
</table>

FOR OFFICIAL USE ONLY - PRIVACY ACT INFORMATION CONTAINED HEREBIN.
### Assessment Event Tracking Report

**jHAVEN - Home Assessment Validation and Entry System**

**Assessment Event Tracking**

**Event Tracking Data**

<table>
<thead>
<tr>
<th>Event Type</th>
<th>User ID</th>
<th>Event Date</th>
<th>Last Name</th>
<th>First Name</th>
<th>SSN</th>
<th>Reason For Assessment</th>
<th>Effective Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014</td>
<td>PLName01</td>
<td>PNName01</td>
<td>999-08-9790</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 11 Feb 2014</td>
<td>PLName01</td>
<td>PNName01</td>
<td>999-08-9790</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 21 Feb 2014</td>
<td>PLName01</td>
<td>PNName01</td>
<td>999-08-9790</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 21 Feb 2014</td>
<td>PLName01</td>
<td>PNName01</td>
<td>999-08-9790</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 21 Feb 2014</td>
<td>PLName01</td>
<td>PNName01</td>
<td>999-08-9790</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
<tr>
<td>Modify</td>
<td>SysAdmin01</td>
<td>Tue, 25 Feb 2014</td>
<td>PLName02</td>
<td>PNName02</td>
<td>999-08-9898</td>
<td>1 - Start of care</td>
<td>2014-02-21</td>
</tr>
</tbody>
</table>

**FOR OFFICIAL USE ONLY - PRIVACY ACT INFORMATION CONTAINED HEREIN.**

Page 125 of 160
Assessment Data Entry – By Status Report

Complete the following steps to run the Assessment Data Entry – By Status report.

NOTE: All User Roles can run this report.

1. Select Assessment Data Entry – By Status from the Reports drop down on the menu bar.

2. The Criteria parameter screen for ‘Assessment Data Entry – By Status’ report displays.
   a. Accessibility Off.
   b. Accessibility On.
3. Select an Agency.
   a. “Agency drop down. Use up and down arrows to select an Agency.*”

4. Select Status.
   a. “Status list. Use up and down arrows to select a status.*”
   b. To select all statuses, hold the SHIFT button while you select or scroll through the list.
   c. To select a few statuses, hold the CTRL button while you select what you need.

5. Select the ‘OK’ button to generate the report.

   Note: Clicking the ‘Cancel’ button to close the parameter screen.

Assessment Data Entry – By Branch Report

Complete the following steps to run the Event Tracking report.

NOTE: Only the System Administrator User ID can run this branch report.

Complete the required fields which are marked with an asterisk (*).

1. Select the ‘Assessment Data Entry – By Branch’ report from the Reports drop down on the toolbar.

2. The Criteria parameter window displays.
   a. Accessibility Off.
   b. Accessibility On.
3. Select Agency.
   a. “Agency drop down. Use up and down arrows to select an Agency*”

4. Select Branch.
   a. “Branch drop down. Use up and down arrows to select a Branch*”

5. Select Status.
   a. “Status list. Use up and down arrows to select a status*”
   b. To select all statuses, hold the SHIFT button while you select or scroll through the list.
   c. To select a few statuses, hold the CTRL button while you select what you need.

6. Select/enter a date range.
   a. “Data Entry Date”
   b. “From*”
   c. “To*”

7. Select the ‘OK button to generate the report.

   NOTE: Clicking the Cancel button to close the parameter screen.

8. The Report Viewer screen opens displaying the generated report.
<table>
<thead>
<tr>
<th>Patient Name</th>
<th>SSN</th>
<th>Gender</th>
<th>Birth Date</th>
<th>Reason For Assessment</th>
<th>Status</th>
<th>Effective Date</th>
<th>User ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI.Name01</td>
<td>990-88-9790</td>
<td>Male</td>
<td>21-12-1919</td>
<td>1 - Start of case</td>
<td>IN_USE</td>
<td>2014-02-21</td>
<td>SysAdmin01</td>
</tr>
<tr>
<td>PI.Name02</td>
<td>990-88-9898</td>
<td>Male</td>
<td>04-14-1910</td>
<td>1 - Start of case</td>
<td>DATA_ENTRY</td>
<td></td>
<td>SysAdmin01</td>
</tr>
</tbody>
</table>
Data Comparison Report
Complete the following steps to run the Event Tracking report.

NOTE: Only the System Administrator and the Data Entry User can run this branch report.

Complete the required fields which are marked with an asterisk (*).

1. Select the ‘Data Comparison Report’ report from the Reports drop down on the toolbar.

2. The Criteria parameter window displays.
   a. Accessibility Off.
      i. Required fields are: Agency and Date Range.

   b. Accessibility On.
3. Select Agency.
   c. “Agency drop down. Use up and down arrows to select an Agency*”
   d. Rules:
      i. System Administrators may select the Agency from multiple options listed in the
         drop down.
      ii. Data Entry Users will have only one options; the agency with which they are
          associated.
4. Select/enter a required date range.
   e. “Data Entry Date”
   f. “From*”
   g. “To*”

5. Select the ‘OK button to generate the report.

   NOTE: Clicking the Cancel button to close the parameter screen.

Closing the Application

Session Time Out

To assist with keeping data secure in jHAVEN, if at any time during data entry there is no activity by the user for 15 minutes, the system will timeout and a warning will be issued.

To continue with the session, the user may click OK. If the user does not click OK before the time displayed on the pop-up, the user will be logged out of jHAVEN and the login screen will be displayed. Any data entered will not be saved.
Save Resources Pop-up Window

If data has been updated, and those screens have not been saved, then the user will see a pop-up window listing those updated screens.
Complete the following steps to save the screens with updates still not saved.

1. Select the resources to save. Each resource listed will have a check box in front of it.
   a. To save an item, make sure the check box is checked.
   b. To close an item without saving it, uncheck the check box.
   c. To save all the items listed, click the ‘Select All’ button.
   d. To NOT save any of the items, click the ‘Deselect All’ button,

Note: The default for these check boxes is that they ARE CHECKED.

Logout

To log out and return to the login screen, select the Logout option from the Security drop down on the menu bar. Unsaved updated Screens will return the Save Resources Pop-up Window.

This allows the user to log into the application again.
Exit

To close jHAVEN, select the Exit option from File drop down on the menu bar. Unsaved updated Screens will return the Save Resources Pop-up Window.

jHAVEN can also be closed by selecting the close icon in the top right corner of the screen.

Data Backup on Close

jHAVEN creates a backup of the database when the application is closed following an active session.

Complete the following steps to close and backup data.

1. Select the Exit option from the File drop down on the menu bar.
2. The Backup jHAVEN Database message displays.

3. Choose one of the following options.
   a. Click Yes to back up the database and close jHAVEN.
   b. Click No to not backup the database and close jHAVEN.

   NOTE: However, if a backup has not occurred within the last 7 days of this active session, the jHAVEN system will not display the above question (steps 2 & 3). Instead, the system will automatically backup the database when closing this session.

   If Yes is selected, the pop-up that indicates the backup is in process will be displayed. When the backup is complete this window closes automatically.
The status of the completed backup will be displayed in another pop-up window providing the status of the completed backup.

NOTE: To restore the database from a prior backup copy, see Miscellaneous System Maintenance, Database Backup and Restore.
Security

All User Roles have access to the Security Menu Bar selection.

The available options are:
- Change Security Answers
- Change Password
- Logout

Change Security Answers

Complete the following steps to change your answers to your security questions:

1. Login to jHAVEN. See Opening the jHAVEN Application.
2. Click on the Change Security Answers option. A pop-up window will be displayed, which requires the confirmation of the users’ current password.
3. Enter the password
4. Click ‘OK’ button.

Note: Clicking the ‘Cancel’ button will end this process.

5. The ‘Security Questions’ pop-up window displays.
6. Enter at least six (6) answers AND tab forward.
7. Click ‘OK’ button.
8. The window is closed and the new answer is saved.

**Change Password**

User passwords may be changed at any time. However, all Users will be asked to change their passwords every 60 days.

Complete the following steps to change a password.
1. Login to jHAVEN. See [Opening the jHAVEN Application](#).
2. Select the ‘Change Password’ option from the Security drop down on the toolbar.
3. The ‘Change Password’ screen displays.
4. Enter the current password in the ‘Password’ text field.
5. Enter a new password in the ‘New Password’ text field.
6. Enter the new password again in the ‘Confirm New Password’ text field.

NOTE: The two passwords must be exact matches and must follow the password rules: Password Rules.

7. Click the ‘Change Password’ button.

Note: Clicking the ‘Cancel’ button will not change the password and end this process.

8. The pop-up window closes and the new password is saved.
Logout

To log out and return to the Welcome screen with the Login pop-up window open, select the Logout option from the Security drop down on the menu bar. The Login window displays. This allows the user to log into the application again.

See the section [Closing the Application](#) for all the options and details for leaving the application.
Help

Help documents are available for all data entry fields and assessment questions.

While performing data entry, the help documents can be accessed by clicking on the Help icon to the right of each field/question. After clicking on the Help icon, a pop-up window will display the information describing the field.

This feature is available on the Administration Screens. The sample shows the seen on the Agency Screen.

Help Option from Menu Bar

Help information can also be accessed by selecting Options from the Help dropdown on the Menu Bar. They are available any time a user is logged into jHAVEN.

Available Options for selection are:
- Search
- Help Content
- About Quality Management System
Help Search

1. Select the ‘Search’ option, which allow input of a specific topic in the ‘Search expression’ field. Click on ‘Go’ to initiate a search to locate information on that topic.

2. The system will display all related options.
3. Click on the option most suited.
4. The list of fields associated with the option selected displays. Click on one of the data fields.
5. The definition of the field is displayed.
6. Return to the original options, click on Search.
7. Click on another option.
8. A new data field list displays.

9. Click on the help tab ‘X’ to close the Search Help option.
Help Contents

Clicking the bold jHAVEN heading, will display ALL help documents for the most current version of jHAVEN.

Expanding the ‘jHAVEN’ topic and then the ‘jHAVEN Item Help by Timeline’, on the left, will allow the user to narrow the list down to a more specific set of items. In the sample below, only the documents for Agency Screen display.
About Quality Management System

Information about the version of jHAVEN currently installed can be found by selecting About Quality Management System from the Help menu.
**QIES Help Desk**
The QIES Help Desk is available for technical support and assistance with problems or questions that may arise regarding the jHAVEN software.

Contact information for the QIES Help Desk:
1-877-201-4721 or help@qtso.com

**Installation Type**
This identifies either the Standalone installation or the Client/Server installation.

**Feature Verification**
Feature Label (jHAVEN) and Feature Version (1.x or 1.x.x) display in the lower left side of the screen. Help Desk Information displays on the right side of the screen.

When the jHAVEN application is accessed and the computer running jHAVEN has an internet connection, the application will compare the version currently installed with the version available on the QIES Technical Support Office (QTSO) website. If a new version of jHAVEN is available, a message will display directing the user to the QTSO website to download the latest version.
Miscellaneous System Maintenance

Passwords

Password Rules
Passwords are case-sensitive. The following rules are displayed at the top of the Change Password screen:

- The new password and the confirm new password must match.
- The new password must be at least 8 characters long.
- The new password must be no more than 20 characters long.
- The new password must not contain any space.
- The new password must not contain the User ID, First Name, Last Name, or Email.
- The new password must not begin with a number.
- The new password can only contain a maximum of 3 repetitive characters.
- The new password must contain at least one for each of the following type of characters:
  - Upper-case Character: A-Z
  - Lower-case Character: a-z
  - Number: 0-9
  - Special Character: - &~'*()}_+=\;';<>.,?/
- The new password must not match any of the user’s most recent 6 passwords.
- The new password will be set to expire in 60 days.

Forgotten Passwords
Complete the following steps:

1. On the login screen, enter User ID and click the ‘Forgot Password’ button.

![Login Screen](image)

2. The ‘Security Questions’ pop-up window displays. It lists three (3) of the six (6) Security questions previously answered: In the sample below the following questions are asked:
   a. What City were you born in?
   b. What is your mother’s maiden name?
c. What was the color of your first car?

3. Answer the security questions.
4. Click the ‘OK’ button to continue to the Change Password screen.

Note: Clicking the ‘Cancel’ button will return the user to the login screen.
Locked Accounts

Data Entry User & View Only User Account Locked
The following message will display if a user account becomes locked.

User may either:
- Follow the instruction for Forgotten Passwords to unlock the account. Security questions must be answered and a new password must be created to continue.
- OR
  - The System Administrator can reset the account following the steps:

1. The System Administrator must log in.
2. On the User screen, select the user that has a locked account (displays in bold in the User Summary section).
3. On this User screen, check the ‘Reset Password/Unlock The Account’ checkbox.
4. Click the Save icon.
5. The user account is unlocked with the password reset to the User ID.

System Administrator Account Locked
If a System Administrator account becomes locked, the same message will display.
The ‘Security Questions’ pop-up window displays.

Follow the instructions for Forgotten Passwords to unlock the account.

Security questions must be answered and a new password must be created to continue.

NOTE: A second System Administrator may log in and reset the account by following the steps as described above.

Help Desk to Unlock Account

If the account cannot be unlocked using one of these options, contact the Help Desk for assistance. See QIES Help Desk. The Help Desk can utilize a secure password reset tool that allows the generic jHAVEN account (used at initial log in) to be reset for the purpose of unlocking the other accounts.

Database Backup and Restore

Database Backup

Database backup occur on automatically on a regular basis.

- See Data Backup on Close for the details of this backup process.
- The jHAVEN application will also automatically back up the database if it is has NOT been backed up in the last 7 days.

Changing the Backup File Location

To change the location used when the jHAVEN database is backed up, use the File Menu dropdown; select ‘Change Backup Location’.
The default location for the backup database is located in a database/backup folder where the application is installed. Only System Administrators may change the location where the backup will be stored.

Complete the following steps to change the location where the backup will be stored.

1. Select the ‘Change Backup File Location’ option from the File drop down from the menu bar.

2. The Change Backup File Location window displays with the current backup location highlighted.

3. Select the desired backup location using the scroll bar
   Or
4. Create a new folder using the ‘Make New Folder’ button.
5. Click ‘OK’ button to set the location and close the screen.

Note: Click the ‘Cancel’ button to close the window without changing the location of the backup files.
**Restore the Database from Backup**

In the event of data loss, System Administrators may perform a database restore from a prior database backup.

A database restore requires the assistance of the QIES help desk (1-877-201-4721 or help@qtso.com).

The User must know the verification information before calling the Help Desk. Use the following steps to locate these features.

1. Click the ‘About Quality Management System’ under the Help Menu.

2. The ‘About Quality Management System’ screen displays.
3. Locate the verification features in the lower left-hand corner of the ‘About Quality Management System’ screen.

   Installation type: QTC MySQL Standalone
   Feature Label: jHAVEN
   Feature Version: 1.0.0
   Feature ID: com.bcssi.jhaven.application
   Build ID: 13

   a. Installation Type
   b. Feature Label: User Tool Acronym
   c. Feature Version
   d. Feature ID
   e. Build ID

4. Call the QIES help desk (1-877-201-4721 or help@qtso.com).
Unlock Client/Server Records

In the Client/Server version of jHAVEN, multiple users access a central database. When this functionality is provided, it is necessary to provide additional safe guards to keep multiple users from trying to open and use the same record all at the same time. The system will lock a record once a user opens it for edit. That user’s User ID will be placed in the ‘Locked’ column in the Assessment Search Summary.

The System Administrator is the only user who can, if necessary, unlock records. They can locate the locked records using one of two methods:
- Use the Assessment Search Screen ‘Unlock Assessment’ button.
- Use the System Administrator Unlock pop-up window.

Unlock using Assessment Search Screen

On the Assessment Search Screen, the assessment records that are locked, will have a User ID in the ‘Locked’ column in the summary result.

Complete the following steps to unlock one of the locked assessments.
1. Click the Search button. (May, or maybe, choose to use the search criteria fields.)
2. Locate the locked assessment that requires unlocking.
3. Highlight the desired assessment.

NOTE: It is recommended that the System Administrator communicate with the user who has the assessment locked, if possible, before doing the unlock.
IMPORTANT NOTE: Only System Administrators have access to this button. It is disabled for all other User Roles. This is only available in the Network Client/Server version of the application.

4. The System can then click on the ‘Unlock Assessment” button.
5. The Assessment will be unlocked.

Unlocking Records using the Locked Pop-up Window

The System Administrator also has an option, ‘Locked Records’, under the Administration Menu item.
Complete the following steps to unlock one or more of the locked records using the Locked Records screen.

1. Click on the ‘Locked Records’ option in the drop down.
2. The Locked Records pop-up screen displays with the following columns:
   a. Record Type will contain one of the valid values: Agency, User, Patient, Branch or Assessment
   b. Identifier will contain the information required to identify the specific record.
   c. User Id is that of the user who has locked the record.
   d. Lock Date is the date that user locked the record.

3. Locate the locked record(s) that requires unlocking.
4. Check the check boxes for each record to unlock.
   OR
5. If all records listed must be unlocked, click on the ‘Select All’ button.
NOTE: It is recommended that the System Administrator communicate with the user who has the assessment locked, if possible, before doing the unlock.

6. Click the ‘Unlock’ button.
7. The “Record(s) Unlocked” message displays. “<<Number>> record(s) have been unlocked.”

![Record(s) Unlocked message]

4 record(s) have been unlocked.

OK